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SOMA NETWORKS INC. ENDUSER PRODUCT 
LICENSE AGREEMENT

THE SOMAPORT™ SUBSCRIBER STATION AND 
PROVIDED SOFTWARE CONTAIN CERTAIN 
COMPUTER PROGRAMS AND OTHER 
PROPRIETARY MATERIAL OF SOMA NETWORKS 
INC. OR LICENSED TO SOMA NETWORKS, INC., 
THE USE OF WHICH IS SUBJECT TO THIS 
AGREEMENT.  BY: (A) SIGNING AN AGREEMENT 
FOR SERVICE WITH YOUR SERVICE PROVIDER; (B) 
OPENING THE SEALED ENVELOPE CONTAINING 
THE SOMAPORT; OR (C) USING THE SOMAPORT, 
YOU ASSENT TO AND ACCEPT THIS ENDUSER 
PRODUCT LICENSE AGREEMENT. IF YOU DO NOT 
AGREE WITH ALL THE TERMS OF THIS 
AGREEMENT YOU MUST RETURN THIS PRODUCT 
(WITH THE ENVELOPE STILL SEALED), ALL 
MANUALS AND DOCUMENTATION, ANY 
SOFTWARE PACKAGES PROVIDED WITH THE 
SOMAPORT AND PROOF OF PAYMENT TO THE 
PLACE YOU OBTAINED THEM FOR A FULL 
REFUND WITHIN THIRTY (30) DAYS OF FIRST 
ACQUIRING THE SOMAPORT, OTHERWISE YOU 
ARE DEEMED TO HAVE ACCEPTED AND AGREED 
TO THESE TERMS AND CONDITIONS.  
UNAUTHORIZED REPRODUCTION, 
DISTRIBUTION, DECOMPILATION OR OTHER 
REVERSE ENGINEERING OF THIS PRODUCT 
INCLUDING ITS HARDWARE AND/OR SOFTWARE, 
OR ANY PORTION OF IT, IS PROHIBITED AND 
MAY RESULT IN SEVERE CIVIL AND CRIMINAL 
PENALTIES, AND WILL BE PROSECUTED TO THE 
MAXIMUM EXTENT POSSIBLE UNDER THE LAW.

1. GRANT OF LICENSE: Subject to the terms of this 
Enduser Product License Agreement (the "Agreement"), 
SOMA Networks, Inc. ("SOMA") grants you (the 
"Licensee") a non-sub-licensable, non-exclusive right 
("License") to use the Product.  "Product" means, 
collectively, the Software and the provided hardware, and 
specifically the SOMAport™ subscriber station and its 
accessories, if any, together with documentation provided to 
you by SOMA or your service provider.  "Software" means, 
collectively, the version of the SOMA software program in 
object code format and all updates to that program 
distributed to you by SOMA, directly or indirectly, by any 
means and includes any firmware provided to you with the 
Product. You have no right, unless otherwise explicitly 
permitted, to receive any source code or design 
documentation relating to the Product. SOMA retains 
ownership of all Software copies.  The Software and this 

License is only provided to you to be used in conjunction 
with the SOMAport provided to you by SOMA or your 
service provider when you subscribed to services that utilize 
the SOMA Air Interface™ wireless technology and is not 
licensed to you to be used for any other purpose.  

2. RESTRICTIONS: Except as reasonably required to use 
the Product strictly in accordance with the License and this 
Agreement, you may not copy any Software. Licensee shall 
not (and shall not allow any third party to): (I) decompile, 
disassemble, or otherwise reverse engineer or attempt to 
reconstruct or discover any source code or underlying ideas 
or algorithms or file formats or programming or 
interoperability interfaces of the Product  by any means 
whatsoever; (II) remove any Product identification, copyright 
or other notices; (III) modify, incorporate into or with other 
software or create a derivative work of any part of the 
Software or Product; or (IV) modify or otherwise alter the 
operation of the Product. Various components, functions, 
routines and/or portions of the Product may be protected by 
Intellectual Property Rights ("IPR") including, but not 
limited to, designs, copyrights, trade secrets and one or more 
patents or pending patent applications.  Licensee is licensed 
under such IPR, if any, only to the extent that such a license 
is required by the licensee to operate the Product in the 
manner intended by SOMA.  No other rights are granted 
under such IPR and no right to repair or replace the Product 
is intended or provided and specifically, no right of 
reconstruction, substitution or repair is provided.

 3. TERMINATION: This License is effective until 
terminated. This License will terminate automatically if you 
fail to cure any material breach, as determined at the sole 
discretion of SOMA, of this Agreement within thirty (30) 
days after such breach first occurs (or immediately in the case 
of a breach of § 2). Upon termination, you shall immediately 
cease all use of the Product and return all of the Product 
including Software, hardware, manuals, documentation of 
any kind accompanying Product  to the place where you first 
obtained such Product or such other location as may be 
designated from time to time. Except for this License and 
except as otherwise expressly provided herein, the terms of 
the Agreement shall survive termination.

4. WARRANTY DISCLAIMER: THE SOFTWARE IS 
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY 
KIND INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE OR NON-
INFRINGEMENT. FURTHER, SOMA DOES NOT 
WARRANT, GUARANTEE OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, OR 
THE RESULTS OF THE USE, OF THE PRODUCT OR 



WRITTEN MATERIALS IN TERMS OF 
CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE.  YOUR SERVICE PROVIDER MAY 
PROVIDE FURTHER WARRANTY COVERAGE FOR 
YOU.

5. LIMITATION ON REMEDIES AND DAMAGES: 
SOMA SHALL NOT BE RESPONSIBLE OR LIABLE 
UNDER ANY CIRCUMSTANCE WITH RESPECT TO 
ANY SUBJECT MATTER OF THIS ENDUSER 
PRODUCT LICENSE AGREEMENT UNDER ANY 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR 
OTHER THEORY: (A) FOR LOSS OR INACCURACY 
OF RECORDS OR DATA OR (EXCEPT FOR RETURN 
OF AMOUNTS PAID TO SOMA THEREFOR) COST 
OF PROCUREMENT OF SUBSTITUTE GOODS, 
SERVICES OR TECHNOLOGY, (B) FOR ANY 
SPECIAL, INDIRECT, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES INCLUDING, BUT 
NOT LIMITED TO, LOSS OF PROFITS, LOSS OF 
SAVINGS, (C) THIRD-PARTY CLAIMS AGAINST YOU 
FOR DAMAGES, OR (D)  FOR ANY MATTER 
BEYOND THE REASONABLE CONTROL OF SOMA 
EVEN IF SOMA AND / OR ITS SUPPLIERS IS/ARE 
INFORMED OF THEIR RESPONSIBILITY. SOME 
JURISDICTIONS DO NOT ALLOW FOR THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU. 

6. UPDATES TO SOFTWARE and TRANSMISSION OF 
PERSONAL DATA: You consent to receive and employ 
updates to Software, without requiring further notice to you, 
that may occur from time to time, as may be necessary, as 
determined at the sole discretion of SOMA and/or your 
service provider, for the use of Product by you and for the 
efficient utilization of services as may be purchased or 
subscribed to by you from your service provider.  You also 
agree to the application of the terms of this Agreement to any 
and all such updates.  You accept and acknowledge that 
Software shall be able to transmit such data as is authorized 
by your service provider in order to allow for the utilization 
of services subscribed or purchased by you in order to allow 
for the billing of such services or as may be necessary by law.

7. MISCELLANEOUS: This Agreement and the License 
provided by this Agreement are not assignable or transferable 
by you without the prior written consent of SOMA. Any 
attempt by you to do so shall be void and void this License. 
Any notice, report, approval or consent required or permitted 
hereunder shall be in writing. If any provision of this 
Agreement shall be adjudged by any court of competent 
jurisdiction to be unenforceable or invalid, that provision 
shall be limited or eliminated to the minimum extent 

necessary so this Agreement shall otherwise remain in full 
force and effect and enforceable. This Agreement shall be 
construed pursuant to the laws of the United States of 
America and the State of California and without regard to 
conflicts of laws principles thereof. If successful in any action 
to enforce this Agreement, SOMA shall be entitled to recover 
costs and expenses including, without limitation, attorney's 
fees. The parties agree that a material breach of this 
Agreement would cause irreparable injury to SOMA, or its 
suppliers, for which monetary damages would be an adequate 
equitable relief and SOMA shall be entitled to any other 
remedies it may have available hereunder or at law. Both 
parties agree that this Agreement is the complete and 
exclusive statement of mutual understanding of the parties 
and supersedes and cancels all previous written and oral 
agreements and communications relating to the subject 
matter of this Agreement. BOTH YOU AND SOMA 
AGREE AND ACKNOWLEDGE THAT SOMA 
RESERVES THE RIGHT TO AMEND THE TERMS 
AND CONDITIONS OF THIS AGREEMENT 
WITHOUT FURTHER NOTICE TO YOU OTHER 
THAN PROVIDING TO YOU THE AMENDED 
TERMS AND CONDITIONS OF THIS AGREEMENT. 
IF YOU DO NOT ACCEPT THE AMENDED TERMS 
AND CONDITIONS AS PROVIDED TO YOU BY 
SOMA, THIS LICENSE SHALL TERMINATE 
IMMEDIATELY. ALL USE OF THE SOFTWARE AND 
ANY SERVICES SUPPORTED BY THE PRODUCT 
AND SOFTWARE MAY CEASE OR BE CAUSED TO BE 
CEASED WITHOUT ANY LIABILITY TO YOU BY 
SOMA AND YOU SHALL RETURN ALL PRODUCT 
HARDWARE, MANUALS, DOCUMENTATION OF 
ANY KIND ACCOMPANYING SOFTWARE TO THE 
PLACE WHERE YOU FIRST OBTAINED SUCH 
HARDWARE, MANUALS, DOCUMENTATION AND 
SOFTWARE.
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Important safety instructions

Installation 
Read instructions — Read and follow all of the safety and operating instructions before 
operating the SOMAport. 

Retain instructions — Retain the safety and operating instructions for future reference.

Heed warnings — Adhere to all warnings on the SOMAport and in the operating 
instructions.

Ventilation — Slots and openings in the SOMAport housing provide ventilation, ensure its 
reliable operation, and protect it from overheating. Do not block or cover these openings. Do 
not place the SOMAport in a built-in installation such as a bookcase or rack unless there is 
proper ventilation or the installation instructions have been adhered to.

Power sources — Use only the type of power source indicated on the label. If you are not 
sure of the type of power supplied to your home, consult your product dealer or local power 
company. 

Grounding or polarization — The plug for the power cord on the SOMAport fits into the 
power outlet only one way. If you are unable to insert the plug fully into the outlet, contact 
your electrician to replace your outlet. To prevent electric shock, do not use this plug with an 
extension cord or outlet unless you can fully insert the blades without blade exposure. Do not 
defeat the safety purpose of this plug.

Power-cord protection — Route power-supply cords so that they are not likely to be 
walked on or pinched by items placed upon or against them. Watch for wear in the cord at 
the plug and socket. 

Accessories — To avoid personal injury or damage to the SOMAport, do not place it on 
an unstable cart, stand, tripod, bracket, or table. 

Attachments — Do not use attachments with the SOMAport that have not been 
recommended in this guide as they may cause hazards.

Water and moisture — Do not use the SOMAport near water or moisture.
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Maintenance and servicing
Cleaning — Unplug the SOMAport from the wall outlet before cleaning. Do not use 
liquid cleaners or aerosol cleanser. Use a dry cloth for cleaning. 

Servicing — Do not attempt to service the SOMAport yourself as opening or removing 
covers may expose you to dangerous voltage or other hazards and may void the warranty. 
There are no user-serviceable parts inside. Refer all servicing to qualified service 
personnel. 

Replacement parts — When replacement parts are required, have the technician verify 
that the replacements being used have the same safety characteristics as the original parts. 
Use of replacement parts specified by the product manufacturer can prevent fire, electric 
shock, or other hazards.

Conditions requiring service — Unplug the SOMAport from the wall outlet and refer 
servicing to qualified service personnel under the following conditions:

The power supply or cord is damaged.

Liquid has been spilled on the SOMAport or it has been exposed to water.

An object has fallen into the SOMAport.

The SOMAport does not function normally even though you have adhered to the 
operating instructions and have made adjustments to only those controls covered by 
the operating instructions. 

The SOMAport has been dropped and a change in performance has occurred.

The SOMAport exhibits a distinct change in performance.

Alerts used in this guide 

 

WARNING:  Where you see this symbol and the WARNING heading,
strictly follow the instructions to avoid personal injury or damage to the product.
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Regulatory Notices

The SOMAport has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, you can try to correct the 
interference by:

Relocating the SOMAport

Increasing the distance between the SOMAport and the device experiencing the 
interference

Connecting the equipment to an outlet on a circuit different from that to which 
the SOMAport is connected 
 

ATTENTION:  Changes or modifications not expressly approved by
SOMA Networks for compliance could void the user's authority to operate the
equipment.

Declaration of Conformity

We SOMA Networks, Inc.,
185 Berry Street, Suite 2000

San Francisco, CA 94107 U.S.A.
(415) 882-6500

declare under our sole responsibility that the product
SOMAport

Complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful 

interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.
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This chapter gives an overview of the SOMAport and shows the layout of the 
front and back panels.
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Overview

The SOMAport is a compact terminal to which you can connect a computer or a 
local area network (LAN) as well as telephones. 

One company, the wireless service provider, delivers both high-speed, always-on 
Internet service and telephone service to the devices that are connected to the 
SOMAport. Because the SOMAport uses wireless technology, there is no wiring 
or cabling connecting it to your wireless service provider’s facilities. Instead, the 
SOMAport communicates with your wireless service provider’s network over the 
air. 

NOTE:  Although this document makes a distinction between the 
wireless service provider, which provides you with telephone and 
Internet service via the SOMAport over a wireless connection, and 
the telephone company, which provides telephone service over a 
land-line connection, it is possible that your telephone company is 
also your wireless service provider. 

Internet service
The SOMAport provides a high-speed Internet connection that is much faster 
than a regular dial-up modem. You can also be connected to the Internet and use 
the telephone at the same time. 

Internet connections are made via Ethernet. You can connect one computer 
directly to the Ethernet port, or you can connect multiple computers to the 
SOMAport using a hub or a switch. If your computer does not have an Ethernet 
card, you may be able to connect using the USB port.  

Telephone service
The telephone service provided by the SOMAport is independent and separate 
from your wired phone service. Wireless services may differ from your traditional 
wired services. Consult with your wireless service provider for details. 
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Radio spectrum
The SOMAport supports various bands of radio spectrum from 1.8–2.7 GHz.

Routine maintenance
The SOMAport does not require maintenance or servicing other than 
occasionally cleaning the outside of the unit. Follow these guidelines: 

Wipe the unit down with a dry cloth periodically. 

Do not use cleaners, solvents, or water.

If you spill liquid inside the SOMAport, unplug it, and call your wireless service 
provider.

Other documents
Once you have installed the SOMAport using this guide, you may need to refer 
to one or more of the following documents. 

Booster Antenna Installation Guide – This document is shipped with the 
optional booster antenna. 

Services documentation – The SOMAport Setup Guide does not describe 
how to use telephone and Internet services. Contact your wireless service 
provider for information.   
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The front panel

There are five lights on the front panel of the SOMAport. These lights indicate 
the state of the SOMAport. Their locations are shown below.   

Lights
The lights have the following functions.  

See the chapter “SOMAport Lights” on page 45 for information about reading 
the lights. 

00076

Status Light

Signal Strength
Indicator Lights

Light Description

Status The top light is the Status light. It indicates whether or not the SOMAport is receiving 
power and functioning normally. 

Signal Strength 
Indicator

The group of four lights below the Status light report on the strength of the radio 
signal.   
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The back panel

The jacks and ports that are used to connect other devices to the 
SOMAport are located on the back panel. The telephone jacks connect 
telephones to the SOMAport, whereas the Ethernet port is used to connect to 
computer equipment. The locations of the connectors are shown below.      

The connectors and switches on the back panel have the following functions. 

Part Description

Booster antenna 
connector

This is the connector to which the optional SOMA Networks external 
booster antenna attaches. 

ATTENTION:  The booster antenna connector should only ever be 
connected to the SOMA Networks booster antenna, as control voltages 
and signals are present at this connector. Other manufacturers’ antennas 
should never be connected to the booster antenna connector as they will 
provide no improvement to reception and will result in irreparable damage 
to the SOMAport, rendering it inoperative.

Continued

Booster antenna 
light

This light indicates which antenna is being used. See “Booster antenna 
light” on page 50.

Ethernet Port

00077

Telephone Jacks

Booster Antenna
Connector

Power Jack

USB Port

Booster Antenna Light
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Cables
The following cables are supplied with the SOMAport. 

USB port This port provides an alternative method for connecting a 
USB-compatible computer or hub to the SOMAport. 

Ethernet port This port connects a computer or a hub to the SOMAport using a straight-
through Ethernet cable (for a computer) or a crossover cable (for a hub). 

The Ethernet lights are located on this port. They indicate the status of the 
Ethernet connection. See “Ethernet status lights” on page 49. 

Telephone jacks These jacks connect telephones to the SOMAport. 

Power jack The power supply plugs into this jack. 

Part Description

Cable Type Description

Ethernet If your computer has an Ethernet card, use the Ethernet 
cable to connect your computer to the SOMAport.

Ethernet cables look similar to telephone cables. However, 
you can tell the two apart because the connector on an 
Ethernet cable is approximately twice as large as the 
connector on a telephone cable.

USB If your computer does not have an Ethernet card, but has a 
USB port, use the USB cable to connect your computer to 
the SOMAport.

00096

00085
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Antennas

The SOMAport is essentially a two-way radio. Inside is an antenna that receives 
radio signals from and transmits radio signals to a basestation operated by your 
wireless service provider. The basestation consists of a tower and an equipment 
box that houses the radio transmitters and receivers that allow the tower to 
communicate with the SOMAport.

The internal antenna 
The SOMAport internal antenna provides good reception in most situations. 
You don’t have to aim this antenna yourself. The antenna tunes itself when you 
plug in the SOMAport. 

SOMAport performance can be affected by the strength of the wireless signal it 
receives. The distance from your wireless service provider's nearest tower, the 
construction of the building, the surrounding terrain, and the placement of the 
SOMAport can potentially affect the strength of the signal. 

The booster antenna 
In rare cases, the internal antenna is unable to acquire a sufficiently strong signal. 
The SOMAport supports a booster antenna to address these circumstances. The 
booster antenna is an external antenna mounted on the outside of your home or 
building. Contact your wireless service provider or retailer for more information 
about the SOMA Networks booster antenna.    

WARNING:  While this device is in operation, a separation distance of
at least 20 centimeters (8 inches) must be maintained between the radiating
antenna and any person exposed to the transmitter in order to meet the
FCC RF exposure guidelines. No change to the antenna or device is
permitted. Doing so may result in the installed system exceeding RF
exposure requirements. This device must not be co-located or operating in
conjunction with any other antenna or radio transmitter. Installers and end
users must follow the installation instructions provided in this guide. 

WARNING:  Only the SOMA Networks booster antenna can be 
connected to the SOMAport. Connecting other manufacturer’s antennas or 
products to the SOMAport will provide no improvement to reception and will 
result in irreparable damage to the SOMAport, rendering it inoperative.
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Connection options for telephones

If you subscribe to or intend to subscribe to telephone service via the SOMAport, 
you can connect telephones to the SOMAport in two ways. You can:

Connect the telephone directly to the SOMAport by plugging it into one of 
the telephone jacks on the back of the SOMAport.

Use your in-building telephone wiring to connect telephones to the 
SOMAport. 

Direct connections
You can use this method if the telephone and computer devices in your home or 
office are near each other and the SOMAport can be placed close enough to allow 
direct connections to all of them, as shown below.    
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Connections to in-building telephone wiring
If you have a number of telephones located in different rooms that you want to 
connect to the SOMAport, you can connect them through the existing telephone 
wiring in your building. This allows you to avoid running long cables throughout 
your home or office to connect your telephones to the SOMAport. 

To connect telephones to the SOMAport using the telephone wiring in your 
home or office, you connect the SOMAport and each telephone to a wall phone 
jack. 

If you decide to use your in-building wiring, do not use wires that are in use for 
phone service from the local telephone company. You can test if your home 
wiring is active by connecting a telephone to a wall telephone outlet and listening 
for dial tone. Contact your wireless service provider for guidelines.    

00104



20

SOMAport Setup Guide



21

This chapter describes how to connect computer and telephone equipment to
the SOMAport.
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An overview of the installation

The following is an overview of the sequence of installation tasks required to 
connect equipment to and power on the SOMAport.

Task See

1 Unpack the SOMAport and make sure you 
have all the necessary parts.

“Unpacking the SOMAport” on page 23

2 Locate the serial number on the base of the 
SOMAport. Write it down in a convenient 
place. You will need this number if you call 
customer support. 

3 Choose a location for the SOMAport. “Choosing the best location for the 
SOMAport” on page 24

4 Connect your computer to the SOMAport. 

You can use Ethernet or, if your computer 
does not have an Ethernet card, USB. You can 
also connect multiple computers to the 
SOMAport using a hub or a switch.

“Connecting a computer via Ethernet” on 
page 25 or 

“Connecting a computer via USB” on 
page 27

5 If telephone service is available in your area 
and you subscribe to it, connect your 
telephone to the SOMAport.

“Connecting telephones to the SOMAport” 
on page 32

6 Connect the power supply to the SOMAport 
and plug in the SOMAport to power it on. 

“Connecting the power supply and 
powering on the SOMAport” on page 36

NOTE:   The SOMAport acquires a 
radio signal that is optimized for it’s current 
location when you power it on. Power on the 
SOMAport only after you have connected 
your equipment to it and positioned it in its 
final location. 

If, once the SOMAport has been installed, 
you decide to move it, power it down first, 
move it to the new location, and then power 
it back on to optimize the signal for the new 
location. 

7 Test the computer equipment connected to 
the SOMAport to make sure you get an 
Internet connection, and if you have 
subscribed to telephone service, make sure 
you get dial tone on the telephone connected 
to the SOMAport.

“Testing your equipment” on page 38

8 You may have to activate full service if your 
service provider hasn’t already done so. 

“Activating full service” on page 43
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Unpacking the SOMAport

Unpack the SOMAport from its box and make sure you have all the pieces shown 
below.    
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Choosing the best location for the SOMAport

Although the SOMAport internal antenna is self-aiming, you can take steps to 
optimize the signal reception and performance of the SOMAport by following 
these recommendations when choosing a location: 

Allow at least 46 centimeters (18 inches) of space around the SOMAport. 

If your home or office has multiple floors, place the SOMAport on one of 
the upper floors, if possible. Avoid putting it in the basement. 

Place the SOMAport higher up in a room. For example, putting it on a desk 
or a shelf will give you a stronger signal than if you place it on the floor. 

Place the SOMAport on a surface such as a desk rather than in a cupboard or 
under a table.

Place the SOMAport near a window rather than on the other side of the 
room.

Avoid placing the SOMAport close to certain electronic devices, such as 
microwave ovens and computer monitors, as this can cause interference.
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Connecting a computer via Ethernet

If your computer has an Ethernet card, use an Ethernet cable to connect your 
computer to the SOMAport. If your computer does not have an Ethernet card 
and it is running Windows 98SE or later, use the USB cable instead. See 
“Connecting a computer via USB” on page 27 for more information. 

NOTE:  If your operating system is Windows 95, Mac OS, or Linux 2.4, you 
must use Ethernet. You cannot use USB.

To connect a computer to the Ethernet port on the SOMAport

NOTE:  To connect multiple computers to the SOMAport, see “Connecting 
multiple computers to the SOMAport” on page 30.

1 Insert one end of the straight-through Ethernet cable into the Ethernet port on 
the back of the SOMAport.

2 Insert the other end of the cable into the Ethernet port on your computer. 

00266
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What’s next
If telephone service is available in your area and you are connecting a telephone 
to the SOMAport, go to “Connecting telephones to the SOMAport” on page 32.

If telephone service is not available in your area or you are not connecting a 
telephone to the SOMAport, go to “Connecting the power supply and powering 
on the SOMAport” on page 36.
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Connecting a computer via USB

Universal serial bus (USB) can be used to connect a computer to the SOMAport. 
A USB cable is shipped with the SOMAport. For USB to work, your PC must be 
equipped with:     

a USB port

Windows 98SE or higher

Even if you have a version of Windows that supports USB, you need to make 
sure your computer’s USB port is enabled and properly set up. 

To determine if the USB port is set up properly

1 Open the Control Panel.

If you have Windows 98/2000/ME, choose Start→Settings→Control Panel.

If you have Windows XP, choose Start→Control Panel.

2 Double-click the System icon.

3 Open the Device Manager:

If you have Windows 98/ME, click the Device Manager tab. 

If you have Windows 2000/XP, click the Hardware tab and then click the 
Device Manager button.

4 Make sure the View device by type radio button is enabled.

5 Click the plus (+) icon next to the Universal Serial Bus Controller option.

If the following drivers are listed, USB is enabled and you can use the USB port: 

USB Host Controller

USB Root Hub

If these drivers are not listed, there are two possible reasons: 

You have a USB Host Controller card installed in your PC, but the USB port is 
not enabled. See your computer’s documentation for instructions on how to 
run your computer’s BIOS Setup program to enable the USB port.

You do not have a USB Host Controller card installed in your PC. You cannot 
use USB unless you purchase a USB Host Controller card. 
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To connect a computer to the USB port on the SOMAport

1 Insert the SOMAport Documentation and USB Drivers CD into the CD-ROM 
drive on the computer.

The SOMAport Documentation window opens.

2 Plug the square connector on the USB cable into the USB port on the back of 
the SOMAport. 

3 Plug the flat connector into the USB port on your computer. 

A hardware wizard window opens. 

See the next section, “Installing the USB software”, for information about how to 
complete the wizard and install the USB drivers.    

00268
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Installing the USB software
The new hardware wizard is different in each version of Windows. Follow the 
on-screen instructions, making sure you select the values indicated in the 
following table for your version of Windows.       

What’s next
If telephone service is available in your area and you are connecting a telephone 
to the SOMAport, go to “Connecting telephones to the SOMAport” on page 32.

If telephone service is not available in your area or you are not connecting a 
telephone to the SOMAport, go to “Connecting the power supply and powering 
on the SOMAport” on page 36.

Windows Version Selections

Windows 98 When prompted for the type of search, select Search for the 
best driver for your device.

When prompted for a location, select CD-ROM drive.
Insert the Windows 98 Second Edition CD if prompted.

Windows 2000 When prompted for the type of search, select Search for a 
suitable driver for your device.
When prompted for a location, select CD-ROM drives.

Windows ME When prompted for the type of search, select Specify a 
location.
When prompted for a location, select Removable Media.

Windows XP When prompted for the type of search, select Install the 
software automatically.

Windows XP finds the driver automatically.
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Connecting multiple computers to the SOMAport 

You can provide Internet service to a number of computers by using a 
networking technology such as 100BaseT (Ethernet networking), 802.11b 
(wireless Ethernet networking), HomeRF (wireless networking), or HomePNA 
(phoneline networking). Be sure to enable all devices to have Internet access 
through the Ethernet port on the SOMAport. 

The following procedure describes how to connect multiple computers via an 
Ethernet hub or switch.    

To connect multiple computers to the SOMAport

1 Insert one end of the straight-through Ethernet cable into the Ethernet port at 
the back of the SOMAport.

2 Insert the other end of the cable into any empty Ethernet port on your hub or 
switch. 
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What’s next
If telephone service is available in your area and you are connecting a telephone 
to the SOMAport, go to “Connecting telephones to the SOMAport” on page 32.

If telephone service is not available in your area or you are not connecting a 
telephone to the SOMAport, go to “Connecting the power supply and powering 
on the SOMAport” on page 36.
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Connecting telephones to the SOMAport

If telephone service is not available in your area or if you do not subscribe to 
telephone service, skip to “Connecting the power supply and powering on the 
SOMAport” on page 36.

Telephone jacks on the SOMAport 
There are two telephone jacks on the back of the SOMAport. The telephone jack 
on the right corresponds to line 1 and the telephone jack on the left corresponds 
to line 2. 

The way in which you connect telephones to the SOMAport depends on three 
things: the number of telephone lines you subscribe to (one or two), the number 
of telephones you connect to the SOMAport, and the types of telephones you 
connect (one-line or two-line telephones). The following table shows how to 
connect telephones to the SOMAport. Detailed procedures follow.   

Telephone
lines Connecting one telephone Connecting two telephones

One You must connect the telephone to 
the line 1 jack. You cannot use the 
line 2 jack.

See “To connect a single telephone 
to the SOMAport” on page 33.

You must insert a duplex adapter into 
the line 1 jack and then connect both 
telephones to the adapter. You cannot 
use the line 2 jack.

See “To connect two telephones to the 
SOMAport (when you have one 
telephone line)” on page 35.

Two You can use either telephone jack. 
If you connect a two-line 
telephone to the line 1 jack, line 1 
will be on the line 1 button on your 
telephone and line 2 will be on the 
line 2 button.

If you connect a two-line 
telephone to the line 2 jack, line 2 
will be on the line 1 button on your 
telephone and line 1 will be on the 
line 2 button.

See “To connect a single telephone 
to the SOMAport” on page 33.  

Connect telephones to both jacks.
If you connect a single-line telephone 
to the line 1 jack, it will be serviced by 
line 1.

If you connect a single-line telephone 
to the line 2 jack, it will be serviced by 
line 2.

If you connect a two-line telephone to 
the line 1 jack, line 1 will be on the 
line 1 button on your telephone and 
line 2 will be on the line 2 button.
If you connect a two-line telephone to 
the line 2 jack, line 2 will be on the 
line 1 button on your telephone and 
line 1 will be on the line 2 button.

See “To connect two telephones to the 
SOMAport (when you have two 
telephone lines)” on page 34.
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NOTE:  To connect a two-line telephone to the SOMAport, your 
telephone service must include two telephone lines. 

To connect a single telephone to the SOMAport

Insert the free end of the telephone cable into the right (line 1) jack.      

00265
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To connect two telephones to the SOMAport (when you have two 
telephone lines)

1 Connect the cable of the telephone you want serviced by line 1 to the right 
(line 1) jack.

2 Connect the cable of the telephone you want serviced by line 2 to the left 
(line 2) jack. 
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To connect two telephones to the SOMAport (when you have one 
telephone line)

1 Insert a duplex adapter into the right (line 1) jack.

2 Insert the cable of one of the telephones into one of the jacks on the adapter.

3 Insert the cable of the second telephone into the other jack on the adapter.    

What’s next
You are now ready to plug in the SOMAport. See “Connecting the power supply 
and powering on the SOMAport” on page 36.
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Connecting the power supply and powering on the 
SOMAport 

The SOMAport does not have a power switch. You turn on the SOMAport by 
plugging it into a power outlet, and turn it off by unplugging it. When you plug 
in the SOMAport, it boots, connects to your service provider’s network, and 
tunes itself (acquires a radio channel).  

To install the power supply and power on the SOMAport

1 Insert the connector on the power cord that is attached to the power supply into 
the power jack on the back of the SOMAport.   

2 Insert the socket end of the power cord into the power supply’s receptacle.

WARNING:  Use only the power supply and power cord that came with the
SOMAport. Using another power supply may damage your equipment and poses
the risk of shock or electrocution. 
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3 Position and orient the SOMAport in the location in which you plan on 
keeping it.

NOTE:  The SOMAport acquires a radio signal that is optimized for its 
location when you plug it in. If you move the SOMAport when it is on, the signal 
may no longer be optimized.  

If, once the SOMAport has been installed, you decide to move it, unplug it first, 
move it to the new location, and then plug it in to ensure the signal is optimized 
for the new location.   

4 Insert the plug end of the power cord into a three-prong grounded power outlet.     

The SOMAport takes up to five minutes to start, train itself to channel conditions, 
and connect to the network. 

The Status light on the front panel is solid amber while performing a self-test. 
When the test has passed, it flashes amber.  

NOTE:  If you need to disconnect the power supply, disconnect the power 
cord from the power outlet first. Then unplug the connector from the back of 
the SOMAport. 

What’s next
When the Status light on the front panel turns green, you are ready to test the 
equipment connected to the SOMAport. See “Testing your equipment” on page 
38.
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Testing your equipment

This section describes how to test Internet and telephone connections. 

Testing your Internet connection
1 Restart your computer while the SOMAport is on.

2 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport. 

Your browser should automatically open to your service provider’s Web site. If it 
does not, enter your service provider’s Internet address.

If you get an Internet connection, you may have to activate full service if your 
service provider hasn’t done so already. See “Activating full service” on page 
43 for more information.

If you do not get an Internet connection, wait a couple of minutes and try 
launching the Web browser again. If you still cannot get a connection, change 
your network settings. See “Configuring network settings for Ethernet 
connections” on page 39.

Testing your telephone connection
Pick up the receiver and listen for a dial tone.    

If you hear a dial tone, the SOMAport has finished booting and is connected 
to your service provider’s network. You may have to activate full service if 
your service provider hasn’t done so already. See “Activating full service” on 
page 43 for more information.

If you hear a series of tones, the SOMAport is still booting. Hang up, and 
listen again in a few minutes. 

If you hear silence, see “Finding problem causes” on page 52.
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Configuring network settings for Ethernet 
connections

Change your computer’s network settings if you could not get an Internet 
connection after connecting your computer to the SOMAport. Several 
procedures follow. Choose the one that is appropriate for your operating system. 
If you are using Windows, you can use the Internet Connection Wizard. 

To change network settings in Windows   

1 Start the Internet Connection Wizard.

2 Do the following to complete the wizard. 

3 Restart your computer.

NOTE:  Do not skip this step.

IF you have ... THEN choose ...

Windows 95 Start→Programs→Accessories→Internet Tools→Get on the Internet

Windows 98/2000/ME Start→Programs→Accessories→Communications→Internet 
Connection Wizard

Windows XP Start→All Programs→Accessories→Communications→New 
Connection Wizard

IF you have ... THEN ...

Windows 95/98/ME/2000 1 Choose I want to set up my Internet connection manually, 
or I want to connect through a local area network (LAN).

2 Choose I connect through a local area network.
3 Leave all checkboxes on the Local area network Internet 

configuration window blank.

4 Choose No when prompted to set up an Internet Mail 
Account.

5 Click Finish.

Windows XP 1 Choose Connect to the Internet.

2 Choose Set up my connection manually.
3 Choose Connect using a broadband connection that is 

always on.

4 Click Finish.
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4 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport. 

Your browser should automatically open to your service provider’s Web site. If it 
does not, enter your service provider’s Internet address.

If you get an Internet connection, you may have to activate full service if your 
service provider hasn’t done so already. See “Activating full service” on page 
43 for more information.

If you do not get an Internet connection, see “Finding problem causes” on 
page 52.

To change network settings in Mac OS 8/9

NOTE:  Your computer must have an Ethernet card and Open Transport. 

1 Click the Apple icon and choose Control Panels→TCP/IP. 
The TCP/IP window opens.

2 Select Ethernet from the Connect via pop-up menu.

3 Select Using DHCP Server from the Configure pop-up menu.

4 Close the TCP/IP control panel.

If you made any changes, you are prompted to save the changes.

5 Restart your computer.

6 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport. 

Your browser should automatically open to your service provider’s Web site. If it 
does not, enter your service provider’s Internet address.

If you get an Internet connection, you may have to activate full service if your 
service provider hasn’t done so already. See “Activating full service” on page 
43 for more information.

If you do not get an Internet connection, see “Finding problem causes” on 
page 52.
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To change network settings in Mac OS X

1 Click the Apple icon and choose System Preferences. 

2 Choose View→Network.

3 Choose Built-in Ethernet from the Show pop-up menu.

4 Click the TCP/IP tab, if necessary.

5 Choose Using DHCP from the Configure pop-up menu.

6 Click Apply Now.

7 Restart your computer.

8 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport. 

Your browser should automatically open to your service provider’s Web site. If it 
does not, enter your service provider’s Internet address.

If you get an Internet connection, you may have to activate full service if your 
service provider hasn’t done so already. See “Activating full service” on page 
43 for more information.

If you do not get an Internet connection, see “Finding problem causes” on 
page 52.

To change network settings in Linux

1 Log in as root.

2 Configure your Linux-based PC to run a DHCP client daemon such as dhcpcd, 
pump, or dhclient.    
In many RedHat-based distributions, this can be done using netconfig, a 
command-line-based utility. See your distribution's documentation for specific 
network configuration procedures. 

3 Reboot your PC.

4 Check the network status by running ifconfig from the command line. 

Under the “eth0” entry, where eth0 is the name of the network card connected to 
the SOMAport, “inet addr” should have a valid IP address.

See the DHCP mini-HOWTO for information about configuring Linux to use 
DHCP, available from The Linux Documentation Project at 
http://www.tldp.org.

5 Restart your computer.
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6 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport. 

Your browser should automatically open to your service provider’s Web site. If it 
does not, enter your service provider’s Internet address.

If you get an Internet connection, you may have to activate full service if your 
service provider hasn’t done so already. See “Activating full service” on page 
43 for more information.

If you do not get an Internet connection, see “Finding problem causes” on 
page 52.
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Activating full service

You may have to activate full service yourself, depending on your service 
provider. 

If, when you launch a Web browser on a computer connected to the SOMAport, 
you can go to any Web site, you already have full service and you have completed 
the installation.

If you can go to your service provider’s Web site only, then your service will be 
restricted until you activate full service. Once full service is activated, you will be 
able to use all of the features to which you subscribe.

To activate full service, launch a Web browser on a computer connected to the 
SOMAport and go to your service provider’s Web page, where you will be guided 
through a sign-up procedure. Alternatively, you can call your service provider.



44

SOMAport Setup Guide



45

This chapter describes how to read the SOMAport lights so that you can
recognize the operating status of the SOMAport, the strength of the radio
signal, the Ethernet status, and if the SOMAport is using the booster antenna
(if attached). 

Contents
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Status light

The Status light is a bicolor light that indicates whether or not the SOMAport is 
powered on and operating normally. It can be either green or amber. 
It is the top light on the front panel of the SOMAport as shown below.   

Status light states 
The Status light can be in one of the following states.  

00093

Status Light

State Description

Off The SOMAport is not plugged in.

See “The SOMAport is not getting power” on page 57.

Amber The SOMAport is performing a diagnostic test. If the light does not 
start flashing after five minutes, the test has failed.

See “There is a fault condition” on page 56.

Flashing amber The diagnostic test passed and the SOMAport is connecting to the 
service provider’s network.

Green The SOMAport is on and has acquired a radio channel. 



 47

SOMAport Lights

Signal strength indicator lights

The signal strength indicator is made up of four lights. They are on the front of 
the SOMAport, below the Status light.    

Signal strength indicator light states 
During SOMAport startup, the four lights that make up the signal strength 
indicator remain off until a radio channel has been acquired. 

When one or more of the lights is solidly lit, the SOMAport has locked in a radio 
signal and is ready to use. The more lights that are lit, the stronger the signal. For 
example, when all four lights are lit, the signal is optimized. If only one light is lit, 
the signal is weak, however, the SOMAport can still operate normally. 
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What to do if performance is affected by a weak signal
Radio signal strength can have an effect on the quality of your telephone calls and 
your ability to access the Internet. If the signal is too weak you may experience 
some of the following problems: 

During telephone calls, you hear noise or calls cut out.

It takes a long time to open a Web page.

You cannot get onto the Internet at all.

These problems may be temporary and due to interference or a temporary 
physical obstruction near your building. 

If performance problems persist and the signal strength lights indicate a weak 
signal, see “The signal is weak” on page 54 for information about the steps you 
can take to optimize the signal. If you cannot improve the signal reception by 
following the recommendations made there, you may have to obtain a booster 
antenna. 
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Ethernet status lights

There are two Ethernet status lights that report on the connection between the 
SOMAport and an Ethernet device (a computer or a hub). These lights are 
located on the Ethernet port on the back of the SOMAport. They do not report 
on the status of USB connections.      

Ethernet status light states
These lights provide information about the SOMAport’s connection to an 
Ethernet device (a computer or a hub) on its Ethernet port.   
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Link Light
(Green)

Data Transmit Light
(Amber)

Link Light Description

Off The SOMAport is not connected to an Ethernet device. 

See “There is no connection between the SOMAport and your 
computer or hub” on page 58.

On The SOMAport is connected to an Ethernet device. 

Data Transmit Light Description

Off The SOMAport is not actively transmitting data on the Ethernet. 

It is normal for this light to be off much of the time since the 
SOMAport is not always transmitting data. 

Flashing The SOMAport is actively transmitting data on the Ethernet. 
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Booster antenna light

This light is located on the back panel, to the right of the booster antenna 
connector. When the SOMAport starts, it checks whether or not a SOMA 
Networks booster antenna is attached to the booster antenna connector. If the 
SOMAport detects a booster antenna, it uses it, otherwise, the SOMAport uses 
the internal antenna.  

Booster antenna light states
This light indicates which antenna is being used.  

00438

Booster Antenna Light

State Description

Off The SOMAport is using the internal antenna.

Green The SOMAport is using the booster antenna.
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This chapter describes the problems the SOMAport may exhibit, the possible
causes of those problems, and the actions you should take to fix them. 
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Finding problem causes

Look up the problem you are experiencing and follow the suggested actions. If 
the recommenced actions do not fix the problem, call your wireless service 
provider for technical support.  

Problem Possible causes Action

Computer

It takes a long time to 
open a Web page 

The signal is weak.

The cable connecting the 
computer to the SOMAport is 
damaged. 

There is Internet congestion.

See “The signal is weak” on page 54.

Replace the cable.

Try again.

You cannot connect 
to the Internet

The changed network settings 
haven’t taken effect.

The channel has been dropped.

The SOMAport is not receiving 
power. 

The SOMAport experienced a 
fault condition during startup.

There is no connection between 
the computer and the SOMAport.

You are using Internet Explorer 
and the LAN settings are not 
properly configured.

The signal is weak.

Reboot your computer.

Unplug the SOMAport and plug it back 
in again.

See “The SOMAport is not getting 
power” on page 57.

See “There is a fault condition” on page 
56.

See “There is no connection between 
the SOMAport and your computer or 
hub” on page 58.

See “Internet Explorer LAN settings are 
incorrect” on page 62.

See “The signal is weak” on page 54.

Continued
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Telephone

Voice quality is poor The telephone is broken.

The signal is weak.

If the telephone is connected to 
the SOMAport via the in-building 
telephone wiring, there may be a 
problem with the wiring. 

Try a telephone that is known to work. 
If the telephone is cordless, try using a 
corded telephone.

See “The signal is weak” on page 54.

Connect the telephone directly to the 
SOMAport or call the telephone 
company to check the wiring in your 
building.

Calls are dropped The signal is weak. See “The signal is weak” on page 54.

No dial tone If you hear a series of tones (not 
a regular dial tone) the SOMAport 
has not finished booting. 

Cable connections are not 
secure.

The telephone’s telephone cable 
is inserted into the SOMAport’s 
Ethernet port. 

The telephone is broken.

The SOMAport experienced a 
fault condition during startup.

The SOMAport is not receiving 
power. 

The signal is weak.

You have connected the 
SOMAport to your in-building 
telephone wiring, however, the 
line to which it is connected is 
also connected to the telephone 
company.

Wait a few minutes and 
try again.

Make sure the telephone cable is 
securely connected to the SOMAport 
and the telephone.

Make sure the telephone is connected 
to a telephone jack. See “Connecting a 
computer via Ethernet” on page 25.

Try a telephone that is known to work. 
If the telephone is cordless, try using a 
corded telephone.

See “There is a fault condition” on page 
56.

See “The SOMAport is not getting 
power” on page 57.

See “The signal is weak” on page 54.

Call your wireless service provider.

Problem Possible causes Action
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The signal is weak

If you are having any of the following problems, the signal to your 
SOMAport may be weak. 

Telephone voice quality is poor or calls are dropped.

It takes a long time to open a Web page. 

You cannot browse the Internet at all. 

To improve reception quality

If the signal strength lights indicate a weak signal or if you are experiencing an 
ongoing performance problem, try the following steps. 

1 Make sure you have located the SOMAport according to the guidelines listed in 
“Choosing the best location for the SOMAport” on page 24.

2 See if a nearby appliance is having an effect on the signal. Do the following for 
each appliance, testing one appliance at a time:

i Turn off the appliance. 

ii While the appliance is off, check the signal strength indicator to see if the 
signal improves. 

If there is an improvement, reposition either the appliance or the 
SOMAport so that they are farther apart. To move the SOMAport, unplug 
it, move it, and then plug it in again. 

If there is no improvement, turn the appliance back on and try another 
appliance.

3 If you cannot improve reception in the SOMAport’s current location, try moving 
it to another location that meets the guidelines outlined on page 24.

NOTE:  Unplug the SOMAport before moving it. Once it is positioned in
its new location, plug it back in again. This ensures that the SOMAport
acquires a radio signal that is optimized for the new location. 

You may need a booster antenna
Reception can be temporarily affected by severe weather conditions such as heavy 
storms, ice, or strong winds. However, if performance problems persist and the 
reception quality does not improve, the signal may be affected by one of the 
following factors: 
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There are obstructions—tall buildings, trees, or mountains—between your 
SOMAport and the nearest transmitting tower. 

Your SOMAport is located at the extreme outer limit of an area covered by 
the transmitting tower.

If you have a persistent signal reception problem, contact your wireless service 
provider to order a booster antenna.
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There is a fault condition 

If the Status light is amber, the SOMAport has detected a fault during the 
diagnostic test. This test is run whenever the SOMAport is powered on after 
being fully shut down. In this situation, you must reboot the SOMAport.   

To reboot the SOMAport 

1 Unplug the SOMAport and leave it off for at least 10 seconds. 

2 Plug the SOMAport back in.

Wait until the Status light on the front panel is green (an indication that the 
SOMAport has acquired a radio channel). 

If the Status light still indicates a problem, call your wireless service provider.
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The SOMAport is not getting power

If the Status light is off, the SOMAport is not getting power. Try each of the 
actions in the following procedure until you locate the source of the problem. 

To check the power 

1 Make sure the SOMAport is plugged in. 

2 Make sure the power cord that connects the power supply to the wall outlet is 
securely connected to the power supply and the wall outlet.

3 Make sure the power cord that connects the power supply to the SOMAport is 
securely connected to the power jack on the back of the SOMAport.

4 Make sure the wall receptacle is working by plugging in an appliance that you 
know works.

5 Check the circuit breaker.

6 If you cannot find the source of the problem, call your wireless service provider.
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There is no connection between the SOMAport and 
your computer or hub

If there is a problem with the physical connection between the SOMAport and 
your computer or hub, you will not be able to browse the Internet. 

The problem may be with the power, cabling, or your network settings. 

Ethernet connection
The Link light on the Ethernet port indicates the status of the connection 
between the SOMAport and an Ethernet device (a computer or a hub). The Link 
light remains off unless an Ethernet device is successfully connected to the 
SOMAport using the Ethernet port.         

USB connection
There is no Link light on the USB port. If you are using USB to connect your 
computer or hub to the SOMAport and you suspect there is a problem with the 
physical connection, follow the procedures documented here to find the cause of 
the problem.   

If you want to verify whether or not there is a physical connection, you can run 
the ipconfig command in Windows. This command returns either the IP address 
(which indicates there is a connection) or a message stating that the cable is 
disconnected. See your Windows documentation for more information.

To check the power 

Check the Status light to make sure the SOMAport is receiving power.

If the Status light is off, see “To check the power” on page 57.
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To check Ethernet cabling

1 Make sure the cable connectors are firmly inserted in the proper Ethernet ports 
on the SOMAport and computer or hub.   

2 Make sure you are using the correct type of cable.

3 Make sure the length of the cable does not exceed 100 meters (328 feet).     
4 If none of the previous steps solve the problem, replace the cable.

You can replace the cable while the SOMAport is on. 

To check USB cabling

1 Make sure the cable connectors are firmly inserted in the proper USB ports on 
the SOMAport and the computer or hub.   

2 Make sure the length of the cable does not exceed 5 meters (15 feet).    
3 If you are using a USB extension cable, check to see if it is faulty by removing 

the USB extension and using a single USB cable between the SOMAport and 
the computer. 

You may have to reposition the SOMAport to do this.

4 Replace the USB cable.

You can replace the cable while the SOMAport is on. 

5 Try getting a connection using an Ethernet cable to see if there is a problem 
with the USB port: 

i Remove the USB cable. 

ii Connect the computer or hub to the SOMAport using an Ethernet cable. 

Configuration Cable type

Ethernet port of a computer Straight-through cable 
This cable is shipped with the SOMAport.

Ethernet port of a hub Ethernet crossover cable 
This cable is not shipped with the SOMAport.
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To verify your network settings (Windows 95 only) 

1 Choose Start→Run.    

2 Enter winipcfg in the Open field and click OK. 

The IP Configuration window opens.

3 Select the network interface that has a default gateway of 192.168.1.1 from the 
pulldown list. 

If this interface has been configured, an IP address was assigned to your 
computer and your computer configuration is not the problem. Your wireless 
service provider may not have set up your account for Internet access. Go to 
your wireless service provider’s registration Web page or call your wireless 
service provider for details. 

If there is no such configuration, make sure your network settings are properly 
configured and then continue with step 4. See “Configuring network settings 
for Ethernet connections” on page 39 for more information.

4 Click Release All.

5 Click Renew.

6 Close the IP Configuration window.

To verify your network settings (all other versions of Windows) 

1 Open the MS-DOS Prompt window using one of the following methods.

Choose Start→Run→Accessories→Command Prompt if you have Windows 
2000.

Choose Start→Programs→MS-DOS Prompt if you have another version of 
Windows.

The MS-DOS Prompt or Command Prompt window opens.

2 Type: 

ipconfig ↵↵↵↵

Your Windows IP configuration appears.
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3 Look for the output section related to the network interface for the 
SOMAport. 

Example:   

1 Ethernet adapter:

IP address . . . . . . . . . . . . .  :  65.94.64.155
Subnet Mask . . . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . . . .:  192.168.1.1

If an IP address was assigned to your computer, then your computer 
configuration is not the problem. Your wireless service provider may not have 
set up your account for Internet access. Go to your wireless service provider’s 
registration Web page or call your wireless service provider for details. 

If an IP address was not assigned, make sure your network settings are 
properly configured. See “Configuring network settings for Ethernet 
connections” on page 39 for more information. 

4 Close the MS-DOS Prompt or Command Prompt window. 
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Internet Explorer LAN settings are incorrect 

If you are using Internet Explorer as your Web browser, make sure the LAN 
settings are properly configured. By default, Internet Explorer is configured to 
automatically detect settings. However, if this option has been disabled, you will 
not be able to connect to the Internet. 

To check Internet Explorer settings

1 Open Internet Explorer.

2 Choose Tools→Internet Options.

The Internet Options window opens.

3 Click the Connections tab.

4 Click LAN Settings.

The Local Area Network (LAN) Settings window opens.

5 Make sure the Automatically detect settings checkbox is enabled.

6 Click OK.

7 Click OK on the Internet Options window.

8 Close Internet Explorer.
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Page numbers in bold point to information in tables and figures.

Index
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states, 50

browsing Internet
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checking
Ethernet cables, 59
Internet connection, 38, 40, 41, 42
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power supply, 57
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USB cables, 59
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using the Ethernet port, 25
using the USB port, 27–29

not connected with SOMAport, 58
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an Ethernet hub to a SOMAport, 30
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directly, 18
through existing wiring, 19
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See also connections
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Ethernet, 39
network, 58
options for telephone equipment, 18
problems with, 52–53
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Internet connection, 52
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desktop power supply, 37
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dropped
telephone calls, 53
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front panel, 14

H
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overview, 22
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J
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L
LAN settings in Internet Explorer, 62
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Internet access to PCs, 30
See also Ethernet hub
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booster antenna, 50
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signal strength indicator, 47–48
status, 46

link light. See Ethernet lights
Linux

network settings, 41

M
Mac OS 8/9

network settings, 40
Mac OS X

network settings, 41
moving the SOMAport, 37
multiple computers

connecting, 30

N
network
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connection problem, 58

network settings, 39
Linux, 41
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Windows, 39
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performance
affected by weak signal, 48
optimizing, 24
problem causes, 54
solving onging problem, 54

poor sound during telephone calls, 53
ports, 12, 15–16

See also Ethernet port and USB port
power

not getting to SOMAport, 57
power jack, 16
power supply

checking, 57
connecting, 36–37
disconnecting, 37

powering on the SOMAport, 36–37

R
radio signals

causes of weak signal, 54
problems from weak signal, 48
reception quality, 17

improving, 24, 54
strength levels, 47

rebooting
SOMAport, 56

S
safety instructions, 5
separation distance

warning, 17
service providers, 12
services, 12

activating Internet and telephone service, 43
documentation for, 13

servicing. See SOMAports
settings

See also network settings
verifying for network, 60–61

signal strength indicator
checking for a weak signal, 54
states, 47–48

signal strength indicator lights. See SSI lights
SOMAport

moving, 37
powering on, 36–37

SOMAports

causes of performance problems, 54
connecting Ethernet hubs to, 30
improving signal strength to, 54
maintenance and servicing, 6, 13
not connected with computer, 58
optimizing performance of, 24
parts shipped, 23
problems and actions, 52–53
rebooting, 56
warning while in operation, 17

SSI
lights, 14

status light, 14
is amber, 56
is off, 57
states, 46

switches, 15–16

T
telephone calls

are dropped, 53
telephone connection

checking, 38
telephone equipment

activating full service to, 43
connecting to a SOMAport

directly, 18
through existing wiring, 19
with one telephone line, 33–35, 38

performance problems and actions, 53
telephone jacks, 16, 32
telephones

with two lines, 32
testing

Internet connection, 38, 40, 41, 42
telephone connection, 38

troubleshooting. See checking
two-line telephones, 32

U
universal serial bus. See USB
unpacking, 23
upkeep. See SOMAports
USB

checking the cable, 59
installing drivers, 29
port, 12, 16
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troubleshooting connection problems, 58
when to use, 25

V
verifying. See checking
voice quality

poor, 53

W
warnings

attaching other devices to the SOMAport, 15, 
17

during SOMAport operation, 17

power supply, 36
weak signal

improving, 48
Web pages. See Internet
Windows

network settings, 39
Windows requirements

for connecting computers to SOMAports, 27
verifying settings, 60–61

wiring
in-building, 19
problem and action, 53
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